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1 Einleitung

CALUMMA ist eine neue Generation von Data-Management-Software, die
Datenkomplexität, Schnittstellenvielfalt und Visualisierung mit Bedienerfreundlichkeit
vereinbart. Dieses Handbuch ermöglicht einen schnellen und einfachen Einstieg in das
CALUMMA Management Tool. Mit der Schnellstart Anleitung können Sie innerhalb weniger
Minuten ihre Datenbankstruktur erstellen und die Daten direkt eingeben. Die Struktur kann
auch im Nachhinein jederzeit bearbeitet werden. Möchten Sie Daten manuell einpflegen
oder editieren, steht Ihnen das automatisch generierte Web Interface zur Verfügung. Auch
das Webinterface reagiert in Echtzeit auf Änderungen im Datenmodell. Unter http://
calumma.at/ kann das Handbuch zum Webinterface abgerufen werden.

1.1 Start

Nach dem Starten des Management Tools wird der Login-Screen geöffnet. In diesem
Dialog müssen zuerst die DB credentials eingegeben und auf "Check" geklickt werden.
Wenn die Verbindung erfolgreich war, können der Benutzername und das Passwort für den
CALUMMA User eingegeben werden.

http://calumma.at/
http://calumma.at/
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Lizenz
Um eine neue Lizenz-Datei zu importieren, klickt man auf die Schaltfläche "Import...".
Danach öffnet sich ein File-Dialog, in welchem die Lizenzdatei "Licence.clm" ausgewählt
werden kann. Falls Ihre Lizenz abgelaufen ist, nehmen Sie bitte Kontakt mit der RISC
Software GmbH auf.
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2 Schnellstart

Dieses Kapitel gibt eine Übersicht zu den wichtigsten Funktionen des CALUMMA
Management Tools, damit möglichst schnell mit dem Arbeiten in CALUMMA begonnen
werden kann. In den nächsten Kapiteln wird auf die einzelnen Funktionen und Ansichten im
Detail eingegangen.

Nach dem Einloggen und Verbinden zur Datenbank erscheint folgender Bildschirm, die 
Ontologie-Ansicht. Links im Ontologie Explorer werden alle Klassen (Entities) und
Enumerationstypen angezeigt. Nach einem Doppelklick auf eine Entity werden rechts die
Attribute angezeigt.

Entities erstellen
Um eine neue Entity zu erstellen, klickt man auf File -> New -> New Class.
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Danach erscheint folgender Dialog:

Hier muss ein "Name" für die neue Entity eingegeben und definiert werden, ob diese
"abstrakt" sein soll. Danach kann man das gewünschte Symbol zur Anzeige auswählen. Mit
"Finish" wird der Dialog geschlossen und die Entity wird erzeugt. Die eben erstellte Klasse
kann per Drag&Drop aus dem Ontology Explorer in den Form Structure Explorer
gezogen werden.

Die neue Entity "Patient" wird jetzt im Form Structure Explorer angezeigt:
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Attribute hinzufügen
Wenn eine neue Entity erstellt wird werden die Attribute "ID" und "Name" automatisch
erzeugt. Weitere Attribute können hinzugefügt werden, indem unterhalb der Tabelle
"Attributes" auf "New Attribute..." geklickt wird.
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In folgendem Dialog können der Name und der Datentyp des Attributes festgelegt werden.
Zusätzlich kann ausgewählt werden, ob Null-Werte erlaubt sind und es können Minimum
und Maximum definiert werden. Nach einem Klick auf "Finish" wird das neue Attribut in der
Tabelle unter "ID" und "Name" angezeigt.
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Daten eingeben
Um Daten einzugeben muss in die Daten-Ansicht gewechselt werden. Dazu klickt man
rechts oben auf den Button "Data" .

Die "Recordlist" ist leer, da noch keine Daten eingegeben wurden. Um einen neuen
"Patient" anzulegen, klickt man mit der rechten Maustaste auf "Patient" und auf "Create new
Record".
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Im nachfolgenden Dialog können für jedes zuvor definierte Attribut Daten eingegeben
werden. Die "ID" wird automatisch erzeugt.

Alle mit "*" gekennzeichneten Felder müssen befüllt werden. Danach kann auf "Finish"
geklickt werden und der Record wird in der "Recordlist" angezeigt.
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3 Ontologie-Ansicht

Dieses Kapitel beinhaltet alle Funktionen der "Ontologie-Ansicht". Es werden der Ontology
Explorer und der Form Structure Explorer erklärt, gefolgt von Entities, Attributen und
Enumerationen. Sobald die Entities erstellt wurden, können diese mittels Beziehungen und
Crosslinks miteinander in Verbindung gebracht werden. Für jede Entity können Formular-
Einstellungen vorgenommen und Benutzerrechte eingestellt werden. Zum Schluss wird der
Ontologie Editor beschrieben, welcher eine Übersicht über die gesamte Datenstruktur und
deren Beziehungen gibt. 

3.1 Benutzeroberfläche

Ontology Explorer
Hier werden alle erstellten Entities und Enumerationstypen angezeigt.

Form Structure Explorer
Die erstellten Entities können per Drag&Drop in den Form Structure Explorer gezogen
werden. Die daraus entstehende hierarchisch angeordnete Struktur stellt die Ontologie dar. 
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Entity Ansicht
Sobald man im Ontologie Explorer eine Entity auswählt, erscheint rechts die Detailansicht
für die jeweilige Entity. In dieser Ansicht kann der Name der Entity verändert werden und es
können andere Einstellungen vorgenommen werden. Es können Attribute hinzugefügt,
verändert und gelöscht werden.
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Logger
Das CALUMMA Management Tool loggt alle Events und Datenbankoperationen mit. Im
Event Logger wird gespeichert wann und welche Entities und Attribute erstellt, verändert
oder gelöscht wurden. Wenn Records erstellt, aktualisiert oder gelöscht werden, wird diese
Information im Database Logger angezeigt. In der History wird eine Liste der geöffneten
Records aufgelistet. Die Einträge in den Logging Daten können jederzeit gelöscht werden
indem man auf das rote X rechts oben klickt.
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3.2 Entities und Attribute

In diesem Kapitel wird beschrieben, wie Entities und zugehörige Attribute erstellt,
bearbeitet und gelöscht werden können. Alle Entities werden im Ontology Explorer
angezeigt und können jederzeit bearbeitet, beziehungsweise gelöscht werden. Jede Entity
kann beliebig viele Attribute unterschiedlicher Datentypen besitzen. Die Attribute werden
in einer Tabelle angezeigt und können ebenfalls bearbeitet und gelöscht werden. Folgende
Datentypen stehen zur Auswahl:

Alphanumeric (String)
Date
DateTime
File
Floating Point Number
Integer Number
JSON
Link
Textfield
Time
True/False
UserID
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Der Datentyp kann auch im Nachhinein noch bearbeitet werden, solange sich noch keine
Daten von der zugehörigen Entity in der Datenbank befinden.

3.2.1 Entities

Entities erstellen
Um eine neue Entity zu erstellen, klickt man auf File -> New-> New Class oder im Ontology
Explorer mit rechter Maustaste auf Classes -> New Class.

In folgendem Dialog können die Details für die Entity definiert werden. Mit "Abstract" kann
festgelegt werden, ob die Entity abstrakt sein soll. Das "Access Level" bestimmt, wer Zugriff
auf die Entity hat.

Access level auswählen:
Everyone: keine Einschränkung, jeder hat Zugriff auf diese Entity.
Group: nur Benutzer einer definierten Benutzergruppe haben Zugriff.
User: nur ein Benutzer hat Zugriff.

Für die Entity stehen verschiedene Icons zur Auswahl. "Finish" schließt den Dialog und fügt
die neue Entity zu den Klassen im Ontology Explorer hinzu.
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Mit Entities können Hierarchien (Spezialisierungen) abgebildet werden. Zum Beispiel
Material -> OP-Material. Um eine neue Spezialisierung zu erstellen klickt man auf die Entity
für welche man eine Spezialisierung erstellen will, mit rechter Maustaste -> "New... ->
Derive a new specialization of Entity". In diesem Beispiel wird eine Spezialisierung von
Material erstellt.

Um eine Entity in die Ontologie aufzunehmen muss diese im Form Structure Explorer
eingefügt werden. Für die Ontologie können mehrere Entities als Wurzelelement (Root-
Entities) definiert werden. Alle erstellten Entities können in einer Baumstruktur beliebig in
die Ontologie eingefügt werden. Der folgende Screenshot zeigt eine fertig erstellte
Ontologie im Form Structure Explorer.
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Entities löschen
Entities können nur gelöscht werden, wenn von der jeweiligen Entity keine Daten mehr in
der Datenbank vorhanden sind. Um eine Entity zu löschen, klickt man mit der rechten
Maustaste auf die Entity und wählt "Delete".
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Dateninitialisierung
Um Daten schnell und einfach von einer CSV-Datei zu importieren kann die Funktion
"Initialize Data" verwendet werden. Diese Funktion ist nur verfügbar solange sich noch
keine Daten in der Datenbank befinden und die Entity eine Root-Entity ist. Attribute für die
Entity können schon vorhanden sein.
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Mit "Browse" kann die CSV-Datei ausgewählt werden. Das File Encoding wird automatisch
erkannt und ausgewählt. Sollte es nicht erkannt werden muss es manuell eingestellt werden.
Das Trennzeichen muss noch angegeben werden und ob die erste Zeile die
Spaltenüberschriften beinhaltet.
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Im nächsten Dialog werden alle Spalten angezeigt. Diese können einzeln aktiviert und
deaktiviert werden. Mindestens eine Spalten muss als Primärschlüssel definiert werden. Falls
die Attribute in der Datenbank noch nicht existieren können sie hier mit dem benötigten
Datentyp erstellt werden. Falls die Entity bereits Attribute besitzt und den gleichen Namen
wie die Spalte in der CSV-Datei hat werden diese Felder automatisch gemappt. Für
Attribute die nicht den gleichen Namen haben wie die Spalte muss ein manuelles Mapping
erstellt werden.

Der nächste Dialog zeigt eine Übersicht über die Attribute die erstellt werden und die
erstellten Mappings. Mit einem Klick auf "Finish" werden die Daten importiert.

3.2.2 Attribute

Attribute hinzufügen
Um Attribute zu einer Entity hinzuzufügen wählt man die Entity mit einem Doppelklick aus.
Danach erscheint rechts die Entity-Ansicht. Als Alternative kann auch ein Rechtsklick auf die
Entity abgesetzt werden und Add... -> Add Attribute ausgewählt werden. Die Attribute
"Name" und "ID" werden immer automatisch erstellt.
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Die Einstellungen für das neue Attribut können in folgendem Dialog vorgenommen
werden. Diese Eigenschaften können später auch noch bearbeitet werden. Mit einem Klick
auf "Finish" wird der Dialog geschlossen und das Attribut in der Tabelle angezeigt. 

Solange sich keine Daten, die dieses Attribut verwenden, in der Datenbank befinden, kann
jederzeit der Datentyp verändert werden. Der Name des Attributs kann auch nach einer
Dateneingabe bearbeitet werden. 
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Mit der Option "Allow Null" kann festgelegt werden, ob für dieses Attribut Nullwerte
erlaubt sind. Ob für ein Attribut mehrere Werte erlaubt sind kann mit der Option "Multiple"
eingestellt werden. 

"MinValue" und "MaxValue" definieren jeweils den minimalen und maximalen Wert für
dieses Attribut. Mit "Order" kann man festlegen, in welcher Reihenfolge die Attribute
aufgelistet werden sollen. Zum Schluss wird in der Tabelle angezeigt, ob ein Attribut
"Locked" (gesperrt) ist. Im Falle einer Sperre kann das Attribut nicht mehr bearbeitet
werden.

3.2.3 Formular Einstellungen

Die Formular Einstellungen für eine Entity werden hauptsächlich für die Darstellung im
CALUMMA Web Interface verwendet. Hier kann man beispielsweise für die einzelnen
Attribute einstellen, ob und welcher Tooltip angezeigt werden soll und in welcher Farbe
und Reihenfolge die Attribute angezeigt werden sollen.

Spalte Bedeutung
Label Dieser Name wird bei Eingabefeldern nachfolgend angezeigt, zB.

Einheiten wie Kilogramm oder Zentimeter können angegeben
werden.
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Use for Name Ist diese Option aktiviert, wird der Wert des Attributs zusätzlich neben
dem Namen angezeigt.

Use for List Bei Aktivierung dieser Option, wird das Attribut in der Tabelle
angezeigt.

Info Link Hier kann ein Link hinterlegt werden. Im Formular wird ein Button
angezeigt der auf den Link verweist.

Tooltip Der hier eingetragene Text wird im Web Interface als Tooltip
angezeigt.

Group Name Damit können mehrere Attribute in einer Spalte gruppiert werden.
Color Die Hintergrundfarbe der Zeile kann damit verändert werden.
Order Ref Die Reihenfolge der Attribute im Namen kann damit angegeben

werden.
Order Table Hier kann angegeben werden nach welchen Attributen die Tabelle

sortiert werden soll. Positive Zahlen führen zu einer aufsteigenden
Sortierung, negative zu einer absteigenden Sortierung.

3.2.4 Berechtigungen

Hier können für bestimmte Benutzergruppen ihre Berechtigungen für Entities, Attribute und
Relationen eingestellt werden. In der Combobox kann - jeweils für die Operationen Create,
Read, Update und Delete - zwischen ALLOW, DENY und INHERITED gewählt werden.
Zusätzlich besteht die Option, alle Berechtigungen zurückzusetzen, gleichzeitig auf ALLOW
oder DENY zu setzen oder Berechtigungen von einer anderen Benutzergruppe zu
übernehmen.
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3.2.5 Hierarchie

Hier werden zusätzlich zu den Attributen Data Validitity Checks und Visibilities angezeigt.
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3.3 Enumerationen

Enumerationen werden im Ontology Explorer unter "Enumeration Types" angezeigt. Eine
neue Enumeration erstellt man unter "File -> New -> New Enumeration Type".

Es erscheint folgender Dialog, um den Namen und das Access Level für die neue
Enumeration einzugeben. Der Dialog wird mit "Finish" geschlossen und die Enumeration
wird unter "Enumerationtypes" angezeigt.

Zu Enumerationen können ebenfalls Attribute hinzugefügt werden. Wie bei Entities werden
die Attribute "ID" und "Name" automatisch erzeugt. Um weitere Attribute hinzuzufügen
klickt man entweder mit rechter Maustaste auf die Enumeration und dann auf Add.. .-> Add
Attribute oder auf die Schaltfläche "Add Attribute..." unterhalb der Attribut Tabelle. Danach
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erscheint ein Dialog, um den Namen und Datentyp für das Attribut festzulegen.

Unterhalb der Attribut-Tabelle befindet sich eine weitere Schaltfläche "Show
Enumerations". Hier werden in einer Tabelle alle definierten Werte für die Enumeration
angezeigt.

Items hinzufügen
Um Werte zu einer Enumeration hinzuzufügen klickt man mit der rechten Maustaste im
Ontology Explorer auf die Enumeration und dann auf "Add Item". In einem Dialog kann der
Name für das Item eingegeben werden. Die neuen Items werden als Sub-Elemente der
Enumeration angezeigt. Durch einen Doppelklick auf das jeweilige Item kann dieses
bearbeitet werden. Des Weiteren können auch Werte für die zusätzlichen Attribute
eingefügt werden. Werte können auch hierarchisch angeordnet werden, indem man sie per
Drag&Drop zu einem jeweiligen Wert hinzufügt.
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Enumerationen zu Entities hinzufügen
Ein Enumerationstyp kann wie ein Attribut zu Entities hinzugefügt werden. In diesem
Beispiel wird die Enumeration "Geschlecht" zu "Patient" hinzugefügt. Dazu wählt man die
Entity "Patient" mit einem Doppelklick aus und zieht dann per Drag&Drop die Enumeration
"Geschlecht" in die Attribut-Tabelle von "Patient". Eine zweite Möglichkeit wäre es, die
Schaltfläche "New Lookup Table" rechts unterhalb der Attribut-Tabelle zu nutzen.
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Mit folgendem Dialog wird eine neue Beziehung (Relation) erzeugt. Beziehungen werden
im nächsten Kapitel genauer beschrieben. Hier kann noch eingestellt werden ob Null-Werte
erlaubt sind und ob mehrere Werte ausgewählt werden können.

Die neue Relation wird in der Attribut-Tabelle von der Entity "Patient" angezeigt.



CALUMMA Management Tool30

© 2018 RISC Software GmbH

3.4 Beziehungen

In diesem Kapitel geht es um Beziehungen (Relations) zwischen Entities sowie Entities und
Enumerationen. Mit Relationen können zwei Relations-Typen realisiert werden: die 1:n
Relation und die 1:1 Relation (Komposition). Die m:n Beziehung wird mit Hilfe von 
Crosslinks abgebildet. Es gibt mehrere Möglichkeiten, Beziehungen zu erstellen. Eine
Möglichkeit wurde bereits im Kapitel Enumerationen vorgestellt. 

Relationen erstellen
Im Menü "File -> New -> New Relation" kann eine neue Relation erstellt werden. Es wird
folgender Dialog geöffnet. Es kann zwischen 1:n und 1:1 Relation gewählt werden. Mit
dieser Relation können in diesem Beispiel mehrere "Behandlungen" zu einem "Patienten"
hinzugefügt werden.
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In der Ontologie im Form Structure Explorer wird die Behandlung als Sub-Element des
Patienten angezeigt. 
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Relationen löschen 
Im Ontology Editor werden alle Relationen in einer Liste angezeigt. Die Schaltfläche mit
der Weltkugel in der Symbolleiste öffnet den Ontology Editor. Danach klickt man unten auf
den Tab "Relations" - damit wird die Liste der Relationen angezeigt. Mit einem Rechtsklick
mit der Maus auf eine Relation kann diese gelöscht werden.

3.4.1 Crosslinks

Crosslinks werden verwendet um m:n Beziehungen zwischen Entities abzubilden.

Crosslinks erstellen
Es gibt zwei Möglichkeiten, einen Crosslink zu erstellen. Entweder im Menü "File -> New ->
New Crosslink", oder per Drag&Drop im Form Structure Explorer mit gedrückter "Alt-
Taste". In folgendem Dialog können alle Details zum Crosslink festgelegt werden.
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Crosslinks löschen
Alle erstellten Crosslinks werden in einer Liste im Ontology Editor im Tab "Crosslinks"
angezeigt. In dieser Liste können diese auch wieder gelöscht werden, indem auf den
Crosslink mit rechter Maustaste und auf "Löschen" geklickt wird.
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3.5 Dependency Details

Mit Dependencies können bestimmte Abhängigkeiten zwischen Attributen definiert
werden. Beispielsweise können bestimmte Attribute ein- oder ausgeblendet werden -
abhängig davon, was bei einem anderen Attribut gewählt wird. 

Um eine neue Dependency zu erstellen klickt man auf "File -> New -> New Dependency".

Danach erscheint folgender Dialog zur Configuration der Dependency. Es kann aus einer
Liste von Dependencies ausgewählt werden.
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Zuerst müssen die Master und Slave Attribute festgelegt werden. Danach kann die Art der
Dependency gewählt werden.

Dependency Beschreibung
Filter Die Auswahl der Enumerationsitems wird eingeschränkt

aufgrund der Auswahl des Master Attributs.
Dynamic Constraint Diese Dependency kann nur bei numerischen Werten

ausgewählt werden. Danach kann ausgewählt werden ob die
Werte gleich, oder ein Wert kleiner oder größer sein muss.

Visibility Ein Attribut wird ein- oder ausgeblendet aufgrund der
Auswahl des Master Attributs.

Editability Legt fest ob ein Attribut bearbeitet werden kann je nach
Auswahl des Master Attributs.

Mapping Hier kann für jedes Item des Slave-Attributes ausgewählt
werden, welche Items des Master Attributs gültig sind.

Optionen
Operator: Diese Option ist verfügbar wenn das Masterattribut ein Attribut mit Mehrfach-
Auswahl ist. In der Combobox kann man auswählen ob die Dependency für einen Wert
gültig ist oder für alle.
Master Record Operator: Diese Option ist verfügbar wenn der Pfad des Masters zu mehr
als einem Masterattribut führt. Von der Combobox muss ausgewählt werden ob die
Dependency nur für einen Record gültig ist oder für alle.
Global: Wenn diese Option aktiviert wird ist die Dependency global gültig.
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Auf der nächsten Seite des Dialogs werden je nach Art der Dependency Items ausgewählt,
welche für einen bestimmten Wert gültig sind.

3.6 Ontologie Editor

Der Ontologie Editor gibt eine Übersicht über die gesamte Ontologie. Er wird über die
Weltkugel in der Symbolleiste geöffnet und erlaubt die Verwaltung der gesamten
Ontologie. Mit Hilfe der Tabs unterhalb der Übersicht können Entities, Attribute, Relationen,
Crosslinks, Expressions, Filter und Visibilities bearbeitet und gelöscht werden.
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4 Daten-Ansicht

Um die Daten-Ansicht zu öffnen klickt man rechts oben auf die Schaltfläche "Data". Links
befindet sich der Ontology Explorer mit der Anzahl der Records der jeweiligen Entity in
Klammern. Die Root-Entity wird in Grün und unterstrichen angezeigt, in unserem Fall die
Entity "Patient".

Um die Records einer Entity anzuzeigen wählt man die entsprechende Entity mit
Doppelklick aus. Die Records werden rechts in der Recordlist angezeigt. 

Records erstellen 
Wenn noch keine Daten vorhanden sind, müssen zuerst Records für die Root-Entity
eingegeben werden. Dazu klickt man mit der rechten Maustaste auf die Entity und wählt
"Create new Record".
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Danach erscheint ein Dialog, in welchem für jedes Attribut Werte eingegeben werden
können. Enumerationswerte können aus einer Liste ausgewählt werden. Wenn für dieses
Attribut in der Ontologie die Option "Multiple" ausgewählt wurde, können hier mehrere
Werte ausgewählt werden indem man die "Strg"-Taste drückt und hält.
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Der neue Record wird danach in der Recordlist angezeigt. Links unten befindet sich die
Toolbox, hier können Daten zu "Behandlungen" und "Material" eingegeben werden, die zu
diesem "Patienten" gehören.

Records finalisieren
Records können finalisiert werden - d.h. dass sie danach nicht mehr bearbeitet werden
können. Dies kann jederzeit wieder aufgehoben werden, indem man mit rechter Maustaste
auf den Record klickt und auf "Re-Open" klickt.
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Records bearbeiten
Records können jederzeit bearbeitet werden, solange sie nicht finalisiert sind. Dazu wählt
man den Record in der Recordlist mit Doppelklick aus. Die Record-Ansicht öffnet sich
unterhalb .
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Records löschen
Einzelne Records können in der Recordlist gelöscht werden, indem auf den Record mit der
rechten Maustaste geklickt wird und "Delete" ausgewählt wird. Eine andere Möglichkeit
wäre es, auf den Record zu klicken und die "Entf"-Taste zu drücken.
Um alle Records einer Entity auf einmal zu löschen klickt man auf die Entity im Ontology
Explorer mit rechter Maustaste und wählt "Delete all". Dies funktioniert allerdings nur, wenn
Records weiter unten in der Hierarchie bereits gelöscht wurden. In diesem Beispiel müssen
zuerst alle Materialien und Behandlungen gelöscht werden, bevor der zugehörige Patient
gelöscht werden kann.
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5 Exploration-Ansicht

Die Exploration-Ansicht bietet mehrere Möglichkeiten, in verschiedenen Experimenten die
der Benutzer anlegen kann, Datensätze und damit ausgewählte Variablen zu analysieren. Es
können beliebig komplexe logische Ausdrücke ("Expressions") erstellt, verschachtelt und
berechnet werden. Aufbauend darauf können diverse Diagrammarten ausgewählt werden,
um Variablen und deren Werte graphisch darstellen zu können.

5.1 Analyse von Records

In der Daten-Analyse-Ansicht ist es möglich, mehrere Records mit verschiedenen Tools zu
analysieren. Von der Daten-Ansicht aus kann man jene Records auswählen, die man
analysieren will, indem man mit der rechten Maustaste darauf klickt und "Analyse" wählt.
Dabei wird bereits ein neues Experiment erstellt, für welches man nur noch den Namen
eingeben muss. Danach öffnet man die Daten-Analyse-Ansicht mit einem Klick auf "OK"
oder auf die Schaltfläche "Exploration".

Danach erscheint ein Dialog, in welchem man die Spalten bzw. Attribute auswählt, welche
für das Experiment verwendet werden sollen. 
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In der Daten-Analyse-Ansicht werden links die Experimente angezeigt wobei jedes
Experiment mehrere Exploration Sets beinhalten kann. Für jedes Exploration Set können
auch nachträglich mehrere Variablen inkludiert werden, diese werden ebenfalls links unter
"Variables" angezeigt.

Um benutzerdefinierte Variablen hinzuzufügen, klickt man mit der rechten Maustaste auf
"Variables" und wählt dann "Define new Variable". In folgendem Beispiel wird die
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zusätzliche Variable "Alter" hinzugefügt. Das Alter soll aus dem Geburtsdatum eines jeden
Records und dem aktuellen Jahr berechnet werden. Dazu wählt man im Kontextmenü 
Numeric Expression -> Date Functions -> Year Diff. Die ausgewählten Operatoren werden im
unteren Teil des Bildschirmes als Baumstruktur angezeigt.

Für den Operator "Year Diff" muss ein Minuend und ein Subtrahend ausgewählt werden. In
diesem Beispiel ist der Minuend das aktuelle Datum und der Subtrahend das Geburtsdatum
des Records.
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Das Alter wird jetzt in einer zusätzlichen Spalte bei den Records angezeigt.
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5.2 Datenvisualisierung

Das CALUMMA Management Tool stellt mehrere Diagramme zur Verfügung, mit welchen
die ausgewählten Daten visualisiert werden können. Um ein Diagramm zu erstellen, klickt
man mit der rechten Maustaste auf das Explorationset, wählt "Explore" und danach den
Diagrammtyp, welcher erstellt werden soll. Im ersten Beispiel wird ein Scatter Chart
ausgewählt.

5.2.1 Scatter Chart

Der Scatter Chart - auch "Streudiagramm" - bietet die Möglichkeit, durch die Positionen der
Datensätze im Plot ähnliche Wertepaare (und damit Abhängigkeiten der beiden Merkmale)
auf einen Blick erkennen zu können. Der Wizard benötigt die Parameter für eine X- sowie
eine Y-Koordinate - also die beiden Merkmale (hier: Gewicht und Alter). Alle Datenpunkte
werden mit der gleichen Farbe gezeichnet, wenn im Feld Color bubbles by der Wert
<none> gesetzt wird. In diesem Beispiel wählen wir Geschlecht aus, um somit  männlich und
weiblich mit zwei unterschiedlichen Farben zu zeichnen.



CALUMMA Management Tool48

© 2018 RISC Software GmbH

Nachdem die benötigten Parameter eingestellt wurden, öffnet sich das Diagramm in einem
eigenen Editorfenster. Der Scatter Chart besteht aus drei Teilen:
1. Visualisation: interaktives Diagramm
2. Legend: Auswahl der anzuzeigenden Datenpunkte
3. Quick Options: Häufig benötigte Optionen

1. Visualisation

Selektieren von Datenpunkten
Die linke Maustaste muss gedrückt werden, um den Startpunkt auszuwählen. Nun mit
gehaltener Maustaste über die zu selektierenden Datensätze ziehen und dann loslassen. Die
ausgewählten Datenpunkte werden mit der Selektierungsfarbe markiert.
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Rechtsklickmenü
Show in RecordView: Selektierte Datensätze werden in der RecordView angezeigt.
Hide selected: Selektierte Datenpunkte ausblenden.
Show all Records: Alle Datenpunkte werden wieder angezeigt.
Remove from ExplorationSet: Löscht selektierte Datensätze aus dem ExplorationSet.
Zoom to SelectedPoints: Vergrößert den Ausschnitt der selektieren Datenpunkte.
Zoom out: Zurückkehren zur ursprünglichen Ansicht.
Export as Pdf: Speichert das Diagramm als Pdf.

2. Legend

Je nach Auswahl der Variable "Color bubbles by" kann die Legende entweder ein 
Farbbalken (für Boolean, Numerische- und Datumswerte) oder eine Liste (Enumerationen)
sein. Am Farbbalken selbst kann man - wie beim Selektieren der Datensätze im
Visualisation-Teil - bestimmte Abschnitte markieren. Datenpunkte, die sich innerhalb der
ausgewählten Werte befinden, werden im Diagramm markiert. Die Kontrollkästchen der
Enumerationstypen blenden die Datenpunkte je nach Auswahl ein oder aus.

3. Quick Options

1. Color by: Farbgebung der Datenpunkte
2. Bubble Size: Größe der Datenpunkte
3. Jitter: Zufallswert, um welchen Datenpunkte von der ursprünglichen Position abdriften;

lässt leichter erkennen, wenn mehrere Datenpunkte auf den selben Punkt zusammenfallen
4. Filter: wenn aktiv werden nur selektierte Datenpunkte angezeigt
5. Dynamic Contrast: Helligkeitsdynamik berücksichtigen
6. Selection Mode: Rechteck oder Freihand Selektierung
7. Legend: Bildlegende ein- oder ausblenden
8. Option Details: Öffnet Optionsmenü
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Optionsmenü
Zusätzlich zu den Quick Options kann hier der Hintergrund (Sparte: Background) verändert
werden. Hier ist All one color (einfarbig) ausgewählt. Die Density Map zeigt die Dichte der
Datenpunkte an. In der Sparte Legend kann die Farbe des Farbbalkens ebenfalls gewechselt
werden. Die Coordinate System Sparte manipuliert die Farben des Koordinatensystems und
der Markierungsfarbe von selektierten Datensätzen. 

In der Menüleiste können unter "File -> Save Current/Applied Settings" die angezeigten/
angewandten Optionen gespeichert und über File -> Load Settings wieder geladen werden.
Unter "Edit -> Set current Settings as Default" können die aktuellen Optionen dauerhaft als
Standard gesetzt werden. Um die ursprünglichen Standardeinstellungen wieder herzustellen
klickt man auf "Edit -> Reset Default Settings".

 



Exploration-Ansicht 51

© 2018 RISC Software GmbH

5.2.2 Box Plot

Der Box Plot kann verwendet werden, wenn man mehr über die Verteilung der Daten wissen
möchte. Dazu wird eine numerische Variable als Y-Achse benötigt. In diesem Beispiel
möchten wir die Verteilung vom Gewicht der Patienten genauer betrachten. Zusätzlich soll
nach dem Enumerationstyp Geschlecht unterschieden werden (Split boxes by) - also
zusätzlich zu der Box mit allen Werten je eine Box für die Gewichtsverteilung männlicher
und weiblicher Patienten angezeigt werden.

Die Box ganz links (Total) berücksichtigt alle Werte, die mittlere nur die weiblichen und die
rechteste nur die männlichen. Über die Kontrollkästchen im Sektor Picking können die
jeweiligen Boxen ein- und ausgeblendet werden.

Über die Outlier Definition können die Minimum- und Maximum-Werte für die Whisker
ausgewählt werden und damit auch, ab wann ein Datensatz als Ausreißer gilt. Die Anzeige
der Ausreißer erfolgt über das Einstellen der Outlier Visibility. Um Ausreißer direkt im
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Diagramm auszuwählen kann die linke Maustaste (gedrückt halten) über die zu
markierenden Ausreißer gezogen werden. Per Rechtsklick auf die Diagrammfläche öffnet
sich ein Pop-up Menü. Mit Show Records of Box werden alle zu der Box zugehörigen
Records in der Record View angezeigt. Show Selected Outliers zeigt alle markierten
Ausreißer in der Record View an.

Möchte man die Farben der Boxen, die Hintergrundfarbe sowie die Darstellungsgröße und
Farbe der Ausreißer ändern, greift man auf die Display Settings zu. Show outliers (Total)
zeigt jene Datensätze an, welche in der Box für alle Werte (Total) als Ausreißer gelten.

5.2.3 Balkendiagramm

Nach Auswahl des Visualisierungstyps Bar Chart (Balkendiagramm) öffnet sich folgender
Dialog, mit welchem man das Diagramm konfigurieren kann. 

Das Merkmal für die X-Achse (Draw Bar Chart for) ist in diesem Fall das Alter. Jeder
einzelne Balken für das Alter kann selbst noch einmal in Unterkategorien unterteilt werden
(Split Single Bars by). Sofern dies gewünscht ist, kann noch der Plot Type ausgewählt
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werden. Dieser bestimmt, ob die Unterteilung gruppiert (grouped) oder gestapelt (stacked)
erfolgen soll. Die "Bar Height" bestimmt, nach welcher Aggregatsfunktion die Höhe der
Balken berechnet werden soll. Zur Auswahl stehen COUNT (Anzahl der Vorkommnisse),
AVERAGE (Durchschnitt), SUM (Summe), MIN (Minimum), MAX (Maximum) und der
MEDIAN. Das Diagramm öffnet sich dann unterhalb der RecordView. 

Sollen Balken ausgewählt werden, hält man die linke Maustaste gedrückt und zieht sie über
die zu selektierenden Balken. Nun können mehrere Aktionen über das Rechtsklickmenü
erfolgen. 

Über Edit können mehrere Datensätze bearbeitet werden. 
Show in RecordView zeigt die ausgewählten Datensätze in der RecordView an.
Remove from Explorationset löscht die ausgewählten Datensätze aus dem Explorationset.
Keep in Explorationset (and remove others) löscht alle nicht markierten Datensätze.

In der Optionsleiste unter dem Diagramm kann über Selection Color die Selektierungsfarbe
geändert werden. Die Klassenanzahl kann je nach Bedarf über den Schieberegler verringert
oder vergrößert werden. Bei einer Unterteilung der einzelnen Bars wird rechts im Diagramm
die Bildlegende angezeigt. Ohne Unterteilung sowie mit der eingestellten Balkenhöhe
COUNT kann eine Normalverteilung über die Balken gelegt werden.
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5.2.4 Liniendiagramm

Der Line Chart punktet vor allem bei Darstellungen, in welchen Werte über einen
bestimmten Zeitraum beobachtet werden können. Wird der Line Chart ausgewählt, öffnet
sich nachfolgender Wizard zum Einstellen der benötigten Parameter. Wenn mehrere
Variablen auf der Y-Achse angezeigt werden sollen können diese gruppiert werden indem
man sie markiert und dann auf den Button unten rechts klickt.
 

Zur Analyse von Laborergebnissen möchten wir in diesem Beispiel die Ergebnisse einer
Untersuchung (Y-Achse) über einen bestimmten Zeitraum (X-Achse) betrachten. Der Vorteil
im Line Chart liegt  darin, dass man mehrere Y-Achsen definieren kann, um Werte
verschiedener Variablen miteinander vergleichen zu können. Für Enumerationstypen können
die Kurven außerdem aufgeteilt werden (Split lines by).

Die Line Width regelt die gezeichnete Linienstärke. Für extrem viele Y-Werte kann es von
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Vorteil sein, die Punkte der Übersichtlichkeit halber zu deaktivieren (Points visible). Die
Bildlegende dient der Beschriftung der Kurven und ist v.a. dann von Nutzen, wenn mehrere
Linienverläufe vorliegen. Werden mehrere Variablen auf der Y Achse angezeigt können
diese synchronisiert werden. Die Y-Achse kann auch nach gruppierten Variablen
synchronisiert werden. Die Y-Achse wird dann skaliert um die Variablen besser vergleichen
zu können.

5.2.5 Parallelkoordinatendiagramm

Für das Parallelkoordinatensystem wird kein Wizard benötigt. Zur Darstellung werden jene
Variablen verwendet, welche im Explorationset definiert wurden. Die senkrechten Linien
sind die Achsen (hier Geschlecht, GeburtsDatum, Gewicht und Alter), welche durch Linien
miteinander verbunden sind. 

Auf jeder Achse kann ein beliebiger Bereich markiert werden. Wenn der "Selectionmode"
auf AND eingestellt ist, werden nur Kurven, welche in den Bereich einer jeden Achse fallen,
markiert. Durch die Verküpfung der Achsen mit OR werden alle Kurven gekennzeichnet, die
mindestens durch einen der markierten Achsenbereiche verlaufen. Bei CLEAR kann nur auf
einer einzigen Achse ein Bereich markiert werden. 

Je nach Höhe des Jitter-Werts bewegen sich die Kurven um einen Zufallswert von der
ursprünglichen Position weg. Durch Aktivieren des Tooltips werden die Werte auf den
jeweiligen Achsen angezeigt, wenn die Maus darüber bewegt wird.
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5.2.6 Clusters

Die Visualisierung von "Cluster" ist das Darstellen und Erkennen von Datensätzen, die
ähnliche Eigenschaften besitzen. Diese graphische Darstellungsart kann auch dann
verwendet werden, wenn mehr als 2 Dimensionen in die Darstellung mit einfließen sollen. 

Liegen viele Punkte eng auf- oder beieinander, bedeutet dies eine hohe Ähnlichkeit. Wie
auch beim Scatter Plot (nur ohne Koordinatensystem) kann auch hier zur Unterstützung die
Density Map als Hintergrund eingestellt werden, um Cluster leichter erkennen zu können. Im
folgenden Beispiel wurden mehrere Dimensionen eingestellt. Als Resultat lassen sich
eindeutig drei zusammengehörige Punktwolken (Cluster) identifizieren. 

5.2.7 Kalender Map

Dieser Diagrammtyp visualisiert ein ganzes Kalenderjahr in einem 2-dimensionalen Raster,
wobei eine einzelne Reihe je einen Wochentag beschreibt. Die Intensität der Farbe ergibt
sich durch bestimmte Aggregationen (z.B. Anzahl der Datensätze, Min bzw. Max-Werte,
Durchschnitt, etc.) deren Wert einem bestimmten Tag (Quadrat) zugeordnet wird. Dadurch
lassen sich auf einfache Weise Trends (z.b. Grippe-Wellen, Komplikationshäufungen,…) über
ein oder mehrere Jahre hinweg erkennen und vergleichen.

Um eine Kalender Map zu erstellen klickt man mit der rechten Maustaste auf die Daten und
wählt "Plotting" und "Calendar Map". Es öffnet sich ein Dialog zum Einstellen des
Datumsattributs für die Map, zum Auswählen der Aggregierungsfunktion und der Variable,
nach welcher die Zellen eingefärbt werden sollen.
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Die Kalender Map wird unterhalb der Records in der Plot-View angezeigt. Um mehrere
Maps hinzuzufügen klickt man auf den Plus-Button "Add calendar map". 

Mit den Optionen unterhalb kann die Map konfiguriert werden. Es kann das Jahr, die
Aggregierungs-Funktion und die Farbe der Kästchen angepasst werden.

5.3 Reports

Reports sind automatisch generierte Berichte, welche zahlreiche Informationen zu den
Datensätzen enthalten. Geöffnet werden können diese über Rechtsklick auf Explorationset -
> Reports. 
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Full Report
Der Full Report enthält die komplette Übersicht über Informationen zu den Datensätzen im
Explorationset. Unterhalb gibt es für jede Variable einen eigenen Tab, in dem zusätzliche
statistische Information zu der jeweiligen Variable vorhanden ist. 
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6 Benutzer-Ansicht

In der Benutzer-Ansicht kann der Administrator Benutzer anlegen, Benutzergruppen
verwalten und Audits der User ansehen. Um in die Benutzeransicht zu wechseln klickt man
auf die Schaltfläche "User" rechts oben. Links befindet sich der "Users Explorer", in welchem
alle erstellten Benutzer angezeigt werden. Benutzer können bestimmten Benutzergruppen
zugeordnet werden. Rechts werden die Audits angezeigt, dies ist ein Protokoll über alle
Änderungen von Records in der Datenbank von dem gewählten Benutzer.

Neue Benutzergruppen erstellen
Benutzer können einer oder mehrerer Benutzergruppen zugeordnet werden. Um eine neue
Benutzergruppe zu erstellen klickt man mit der rechten Maustaste in den "Users Explorer"
und wählt "Create New Group".



CALUMMA Management Tool60

© 2018 RISC Software GmbH

Danach erscheint ein Dialog, in welchem ein Name für die Gruppe eingegeben werden
muss. Nach einem Klick auf "OK" wird die Gruppe im "Users Explorer" angezeigt.

Neue Benutzer erstellen
Mit einem Rechtsklick auf die neu erstellte Gruppe können neue Benutzer hinzugefügt
werden, Untergruppen können erstellt werden und die Gruppe kann umbenannt werden.
Wird eine Gruppe gesperrt, kann sie danach nicht mehr verändert werden. Es gibt die
Möglichkeit Gruppen zu deaktivieren und zu löschen. Beim Deaktivieren werden alle
Benutzer dieser Gruppe deaktiviert und dieser Gruppe können keine neuen Benutzer
zugewiesen werden.
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Nach einem Klick auf "Add new User" öffnet sich folgender Dialog. Hier muss der Name
und das Passwort für den Benutzer eingegeben werden. Außerdem kann die Rolle für den
Benutzer festgelegt werden. Aus der Combobox kann zwischen User, Admin, GroupAdmin
und Viewer gewählt werden. Damit wird definiert, welche Rechte der neue Benutzer hat.

Rolle Rechte
Admin Benutzer und Benutzergruppen anlegen, Datenstrukturen erstellen,

Explorationsets erstellen, Daten eingeben,
GroupAdmin Benutzer dieser Benutzergruppe verwalten, Explorationsets erstellen,

Daten eingeben
User Daten eingeben, Explorationsets erstellen
Viewer Daten betrachten, Explorationsets erstellen



CALUMMA Management Tool62

© 2018 RISC Software GmbH

Diese Daten können auch im Nachhinein jederzeit bearbeitet werden, indem man den
Benutzer mit Doppelklick im "Users Explorer" auswählt. Es erscheint in der rechten
Bildschirmhälfte die Detailansicht für den ausgewählten Benutzer.

Zusätzlich wird hier unter "Assigned Usergroups" angezeigt, welchen Benutzergruppen ein
Benutzer zugeordnet ist.
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7 Tools und Optionen

Im Menüpunkt "Tools" befinden sich eine Reihe von Funktionen, die in diesem Kapitel
erklärt werden.

Clean
Die "Clean"-Funktion entfernt alle NULL-Werte oder Referenzen zu NULL-Werten.

Optimize Tables
Beim Aufruf dieser Funktion werden die Tabellen- und Tabellenindexdaten reorganisiert um
Speicherplatz zu reduzieren. Dadurch kann effizienter auf die Tabellen zugegriffen werden.

Add missing GUIDs
GUID steht für Global Unique Identifier und dient als eindeutige ID beim Vergleich von
Records in unterschiedlichen CALUMMA Instanzen vom gleichen Schema. Wird ein
Datenbankschema von einer älteren CALUMMA Management Tool Version als 10 geladen,
besteht die Möglichkeit, dass nicht alle Records eine GUID besitzen. Mit dieser Funktion
wird zu allen Records eine GUID erzeugt falls noch keine existiert.

Unlock all Records
Nach dem Ausführen dieses Tools wird der Locked-Status bei allen Records auf "Unlocked"
gesetzt. Danach können alle Records wieder bearbeitet werden.
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Preferences
Im "Menü -> Tools -> Preferences" können verschiedene Einstellungen vorgenommen
werden.

Exe Launcher
Mit dem Exe-Launcher kann über das CALUMMA Management Tool mit einem Button eine
externe Anwendung gestartet werden. Die Daten werden aus einem Explorationset geladen
und in eine CSV Datei gespeichert. Diese Datei wird dann der Anwendung als Parameter
mitgegeben. Mit dem Optionen-Menü kann der Launcher konfiguriert werden. Der Pfad zur
Exe muss angegeben werden und das Verzeichnis in welchem die CSV Datei gespeichert
werden soll. Es können zusätzliche Parameter angegeben werden und ein Tooltip für den
Button kann definiert werden.
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R-Connector
Über das Management Tool kann R oder R-Studio gestartet werden. Bei den Optionen
muss der Pfad zur EXE angegeben werden und ein Verzeichnis wo die CSV Datei
gespeichert werden soll. Diese CSV Datei wird als Parameter der EXE übergeben. 

Um die Daten in R zu exportieren klickt man mit der rechten Maustaste auf die Daten und
wählt "Export..." und "Export to R". Die ausgewählten Daten werden in eine CSV Datei
gespeichert und R als Parameter übergeben. Im Hintergrund wird ein R-File erzeugt
welches die Daten aus dem CSV File einlest und in R ladet.
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